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CL-713/714 CODESYS DOCUMENTATION 

OVERVIEW 

This document is meant to assist in guiding you through seƫng up and developing with a CL-713/714 display in CODESYS. 

 

INSTALLING PACKAGE 

To add the CL-713/714 device to CODESYS you will first need to obtain the .package file, which can be downloaded from the following 
locaƟon: 

*DOWNLOAD .PACKAGE FILE HERE* 

Once downloaded you will need to install it into your CODESYS environment. 

1. Launch your CODESYS Installer 

 
  

2. Select “Change” and then “Install File(s)” 

https://www.hedcontrols.com/HED-Files/Resources/Product-Resources/HED_CL-713_CL-714_CODESYS_1.0.0.7.zip
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3. Navigate to and select the .package file that was downloaded 

  
 

Note: CODESYS may warn that the package file is not signed and prompts you if you would like to conƟnue with the installaƟon, conƟnue 
with the installaƟon. Once the process is complete you can launch CODESYS and have the ability to add this device to your project. 
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CREATING A PROJECT 

1. Launch CODESYS and select File->New Project 

2. Select Standard Project 
 

 
 

3. When it launches it will ask what Device and Language you would like to use, for the Device choose the HED CL-713/714 Controller 
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ADDING I/O 

1. To add I/O to the CL-713/714 right click the top-level device and then select Add Device 
2. Under Miscellaneous follow the tree down unƟl you see Connector A. Select that and click Add Device. 

 
 



HEDcontrols.com  |  800-398-2224  |  Confiden al & Proprietary CL-6000 Series User Manual  |  Rev040125  |  Page 7 

3. AŌer being added your Device tree should look similar to this: 
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4. To add IO you can right click on any of the <Empty> sockets, select Plug Device and choose an IO from the list 

 
Each IO has a Pin associated with it leƫng you know what pins can be configured for what IO: 

 
As a note, you can configure a pin with an input and an output and the system will not flag an error so be careful and keep track of what 
pins are configured 
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5. It is highly recommended that you adjust the PLC Seƫngs to allow the use of symbolic access of IO to make programming easier. You 
can do this by double clicking the CL-713/714 Device and going to the PLC Seƫngs. 

 
Keep in mind that this seƫng is a per project seƫng and will need to be done for every new project that you do (the property is Ɵed to 
project not workspace). 

I/O TYPES AND CONFIGURATION 

STB/STG/TRISTATE INPUTS 

STB, STG, and TRISTATE inputs refer to digital inputs where the input is ON when connected to their designated type and OFF when not i.e. 
STB is ON when it sees baƩery voltage and OFF when it see ground and vice versa for STG, it is ON when it sees ground and OFF when it 
sees baƩery voltage. TRISTATE specifically can detect when connected to a source, ground, or open. 

All three of these inputs have 2 properƟes associated with them for configuraƟon, DebounceTimeOn and DebounceTimeOff 
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Both of these values default to 5 with a unit of 10mS, so by default the debounce Ɵme for both is 50mS. Debounce is a property that the 
input must see the value for at least this long to be considered ON/OFF. 

For example, a STB input sees baƩery voltage, it must see that voltage for at least 50mS before the input will consider it valid and report 
the input as ON. With the symbolic IO enabled, accessing the input value would be done from looking at the input property. 

  
 

RTD INPUT 

RTD inputs refer to inputs that read in a resistance value and report back the resistance in ohms. This input has 1 property, Analog HS Filter 
Frequency. That property should be set to 0 so that the input is read only once per loop. With symbolic IO enabled, accessing the input 
would be done from the Input_RTD property. 
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VTD INPUT 

VTD inputs refer to inputs that read in a voltage and report back what that voltage is in mV. Generally, this is a 0-5V range with the 
excepƟon of the BaƩery Voltage Pin. This input has 1 property, Analog HS Filter Frequency. That property should be set to 0 so that the 
input is read only once per loop. With symbolic IO enabled, accessing the input would be done from the Input_VTD property. 

  
 

PWM INPUT 

PWM inputs read and report back the on-percentage duty cycle of a square wave signal in a percentage of 0-100.0% (real value reported is 
0-1000). This input type currently has no adjustable parameters. Using the symbolic IO you can access the input value by looking at the 
Input_PWM property. 
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FREQENCY INPUT 

Frequency inputs read and report back the frequency of a square wave signal in Hz. This input type currently has no adjustable parameters. 
Having the symbolic IO enabled you can access the input value by looking at the _Input_Frequency property. 

  
 

COUNTER INPUT 

The counter input is a pulse counter that will report back the number of square wave pulses the input experiences over the loop Ɵme of 
the applicaƟon. The counts will be accumulated based on the falling edge detected. There aren’t any adjustable parameters for this input 
type. If you have the symbolic IO enabled you can read the number of pulses by accessing the _Input_Counter property. 
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BUTTONS 

The buƩons are grouped together into a single socket called BuƩons. Add them to a socket just as you would for any other I/O (Right click 
Plug Device). Double clicking on the object you can view the I/O Mapping to see all 4 buƩons and the 4 NavigaƟon buƩons pre-defined. 

  
If you set up your device to uƟlize the symbolic IO you can reference the buƩons themselves based on the Channel Name 

  
Otherwise, you will have to reference them by their Address which can change depending on what socket you plugged the BuƩons into on 
the Connector A Device. 
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BUTTON BACKLIGHT 

This is an output that allows you to control the backlight brightness of the buƩons. If you have the symbolic IO mapping enabled you can 
access the 2 properƟes easily to assign a value to. The BuƩonBacklight_Set_Brightness is what you would assign a value of 0-1000 (100.0%) 
to control the backlight. The second property _Actual_Brightness is what the driver is actually seƫng the backlight to and would only differ 
from the _Set_Brightness if the controller was throƩling the backlight due to thermal condiƟons. Use the _Actual_Brightness for displaying 
what the backlight is on a visualizaƟon and use _Set_Brightness to actually control the backlight. 

  
 

KEYSWITCH AND BATTERY INPUTS 

The Keyswitch and BaƩery Inputs are already pre-socketed into the project when you add the CL-713/CL-714 device. These monitor baƩery 
voltage (in mV) and the switched power pin (TRUE/FALSE for detecƟon) for you. With the symbolic IO enabled you can access the values 
read by them by looking at their respecƟve properƟes. 
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AMBIENT LIGHT SENSOR 

The ambient light sensor is another input that is pre-socketed into the project upon adding the CL-713 device. This is a sensor that reports 
back a reading, in lux, based on the amount of light it is exposed to where the higher the value the more light it is exposed to. With the 
symbolic IO enabled you can access the value read by the sensor but looking at the sensor property. 

  
 

ENCODER INPUT 

The encoder inputs are a pair of pins that act as 1 input type. These inputs do not have any configurable parameters and reading it will 
return a signed value giving you the amount of change and in which direcƟon for that given applicaƟon loop cycle. You will need to create 
and maintain your own count within your code. With the symbolic IO enabled you can obtain the value by looking at the input parameter. 
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DIGITAL OUTPUT 

Digital outputs are controlled to be ON and OFF without any variance between. These outputs will have a few configuraƟon parameters: 

• SoŌwarefuse trip point: The value in mA in which a soŌware fuse will be set at so that when the output is detected to go over that 
point it will trigger an overcurrent error. 

• SoŌwarefuse Debounce Ɵme: The Ɵme in 10mS in which the output current needs to be above the trip point for the overcurrent error 
to trip. 

• OpenCircuit-DetecƟon: A value in mA in which the open circuit detecƟon will turn on when below it. 
• Open when Off-DetecƟon-Mode: Can enable or disable the detecƟon for open circuit when off. 
• Load Type: Can enable certain protecƟons on the pin based on the type of load, Load NA and Non-InducƟve are standard loads and 

lastly if you are connecƟng to an inducƟve load ensure you use the InducƟve Load type. 

With the symbolic IO enabled, all that needs to happen to turn the output on or off would be to set the Boolean parameter true or false. 

  
 

PWM OUTPUT 

The PWM output is an output that has a fixed frequency and a variable duty cycle that you command from 0-1000 (0-100.0%). This output 
type has some configurable parameters:  
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• SoŌwarefuse trip point: The value in mA in which a soŌware fuse will be set at so that when the output is detected to go over that 
point it will trigger an overcurrent error. 

• SoŌwarefuse Debounce Ɵme: The Ɵme in 10mS in which the output current needs to be above the trip point for the overcurrent 
error to trip. 

• OpenCircuit-DetecƟon: A value in mA in which the open circuit detecƟon will turn on when below it. 
• Open when Off-DetecƟon-Mode: Can enable or disable the detecƟon for open circuit when off. 
• Load Type: Can enable certain protecƟons on the pin based on the type of load, Load NA and Non-InducƟve are standard loads and 

lastly if you are connecƟng to an inducƟve load ensure you use the InducƟve Load type. 
• Frequency: The frequency in which you desire the output to operate at ranging from 50-1000Hz. 

With the symbolic IO enabled, all that needs to happen to turn the output on or off would be to set the output parameter to a value 
ranging from 0-1000. 

 
 

FREQUENCY OUTPUT 

The Frequency output is an output that has a fixed Duty Cycle and a variable Frequency that you command up to 1000Hz. This output type 
has some configurable parameters:  

• SoŌwarefuse trip point: The value in mA in which a soŌware fuse will be set at so that when the output is detected to go over that 
point it will trigger an overcurrent error. 

• SoŌwarefuse Debounce Ɵme: The Ɵme in 10mS in which the output current needs to be above the trip point for the overcurrent 
error to trip. 

• OpenCircuit-DetecƟon: A value in mA in which the open circuit detecƟon will trip. 
• Open when Off-DetecƟon-Mode: Can enable or disable the detecƟon for open circuit when off. 
• Load Type: Can enable certain protecƟons on the pin based on the type of load, Load NA and Non-InducƟve are standard loads and 

lastly if you are connecƟng to an inducƟve load ensure you use the InducƟve Load type. 
• Duty Cycle: Set the Duty Cycle of the signal from 100 to 900 (10.0-90.0%) 

With the symbolic IO enabled, all that needs to happen to turn the output on or off would be to set the output parameter to a value 
ranging from 0-1000 and it will operate at the configured duty cycle with the commanded frequency. 
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ECC OUTPUT 

The ECC output is an esƟmated constant current output, meaning it will try to output a specific amount of current that the user 
commands, in mA. Since there is no feedback to measure the actual current, the esƟmated value is determined internally through circuitry 
and algorithms. This output has a few things to configure with a bit of a nuance. 

• SoŌwarefuse trip point: The value in mA in which a soŌware fuse will be set at so that when the output is detected to go over that 
point it will trigger an overcurrent error. 

• SoŌwarefuse Debounce Ɵme: The Ɵme in 10mS in which the output current needs to be above the trip point for the overcurrent 
error to trip. 

• OpenCircuit-DetecƟon: A value in mA in which the open circuit detecƟon will turn on when below it. 
• Open when Off-DetecƟon-Mode: Can enable or disable the detecƟon for open circuit when off. 
• Load Type: This output will require the load type to be set so you must use the InducƟve or Non InducƟve load type to allow the 

calculaƟons to run correctly. 
• Frequency: The frequency in which you desire the output to operate at ranging from 50-1000Hz. 
• Duty Cycle Offset: This property is an offset to start the PID output command at a higher setpoint to allow for slightly faster 

response/ramp up to target. 
• P gain: The P Gain term for the internal PID control loop that will run to maintain a constant current output. 
• I gain: The I Gain term for the internal PID control loop that will run to maintain a constant current output. 
• D gain: The D Gain term for the internal PID control loop that will run to maintain a constant current output. 

Having the symbolic IO enabled you can command a current by seƫng the property to the value you desire. 
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BACKLIGHT OUTPUT 

This is an output that allows you to control the backlight brightness of the display. If you have the symbolic IO mapping enabled you can 
access the 2 properƟes easily to assign a value to. The LCDBacklight_Set_Brightness is what you would assign a value of 0-1000 (100.0%) to 
control the backlight. The second property _Actual_Brightness is what the driver is actually seƫng the backlight to and would only differ 
from the _Set_Brightness if the controller was throƩling the backlight due to thermal condiƟons. Use the _Actual_Brightness for displaying 
what the backlight is on a visualizaƟon and use _Set_Brightness to actually control the backlight. 

  
 

5V POWER SUPPLY 

The 5V supply is actually 2 pins, a supply (Pin 18) and a return (Pin 17). You will need to plug both into sockets in order to use this feature. 
Both of the pins will have a min and max voltage seƫng, the min must remain below the max. You will want to set your min and max for 
both pins and then use the _AcƟvate property to turn them on (both pins need to be turned on for it to work properly). 
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CAN – SENDING AND RECEIVING CAN MESSAGES/SIGNALS 

There are a few ways of sending and receiving CAN signals but the way we suggest will be through the use of a J1939 CAN library stack that 
is already included with the CL-713/714 Device.  

Before sending or receiving CAN messages, you need to define the CAN bus devices.  

1. Right click on the HED CL713/CL714 Controller and select Add Device 

 
2. It will open a window where you can expand Fieldbuses. Under Fieldbuses you can select CANbus then select CANbus (not NetX 

CANbus). 
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3. Double click on your CANbus device to bring up its properƟes editor. Under the General tab is where you select the CAN line and set 
the baud rate (CAN 1 is Network 0; CAN 2 is Network 1). 

  
 

4. Once configured, you will need to add the J1939 Device by right clicking on the CANbus Device and selecƟng Add Device. You now have 
the opƟon to add a J1939 Manager or a CANopen Manager. If you have an EDS file, select CANopen. For engine/chassis interfaces 
select SAE J1939 Manager. 
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5. It is at the J1939 Manager that you can import DBC files to be used later by your J1939 devices. Under the General tab you can Install 

DBC files as databases to be used later. 
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You are now ready to add a J1939 ECU device – you need to create a separate device for each source address your applicaƟon will be 
sending or receiving messages. 

 

  
  

To begin adding messages and/or signals you can double click on the J1939_ECU device to bring up a GUI that will allow you to begin 
configuring that CAN device.  
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Preferred Address is the Source Address of this device, i.e. most engines would be 0 and some transmissions would be 3 or 11 etc. 

Please note: As this is an external device (Local Device is not checked) the messages defined under Tx Signals are the messages that will be 
Received by the CL-713. If you want to use the CAN Device to send messages, you need to check Local Devices. 

To add a message that would be transmiƩed by that remoted device to the display you can go into TX Signals and click Add PG 
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By default, there is no database loaded but if you had a database of messages you could choose directly from that, otherwise Custom 
needs to be chosen. Under Custom you can define the parameters of the message with a restricƟon that the PGN (PDU Specific and PDU 
Format) must remain within the standard J1939 defined space – you cannot define a proprietary message for the device configured as is. 
To define a proprietary message, you would need to set the device to a Local Device. 

AŌer adding a PGN you can then begin adding signals to that PGN, defining how long the signal will be, scaling, offset, name, byte order, 
etc. Once the signal is added you can then adjust the bit posiƟon in which it will start from. 

• Length is the length of this data value in bits 
• Byte PosiƟon is the starƟng bit within the 8 data bytes of the CAN message 
• Bit PosiƟon is the starƟng bit 
• Scaling is a mulƟplier to the value extracted from the CAN message. 
• Offest is added to the value extracted from the CAN message 

  

To uƟlize the data you are extracƟng from CAN messages, simply use the Signal name in your applicaƟon. This line sets a local variable 
RPM_Command to the Engine_Speed read from a CAN message and adds 50 to that value. 

  

Choosing to click the box for Local Device this would designate the ECU device to be a simulated CAN device coming from the 
controller/display itself. You will see that a new tab appears, P2P Rx Signals 
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When set as a local device the Tx Signals are the defined messages that the display will transmit out and the P2P RX Signals are the 
messages it would expect to receive. The Preferred Address in regard to Tx Signals is the Source Address that the message will be 
transmiƩed with, but in regard to P2P RX Signals it would be the DesƟnaƟon Address of the message ID. AdjusƟng the P2P RX Signal source 
address will be done within that tab directly under the message seƫngs of the PG you have defined. 

To define a message to be transmiƩed from the display go under Tx Signals, like before, and click the Add PG and then define your message 
under the Custom tab. With the device now selected as local, you will be able to define a PGN within the proprietary realm of IdenƟfiers. 
For these transmiƩed messages, selected the PGN allows you to configure how the message is sent: On Change, Cyclic, etc. 

  

To define a message to be received by the display, you would click the P2P RX Signals and add a PG there. Or you can add a new device to 
receive those messages. 
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CREATING SCREENS 

Screens are added through the use of visualizaƟons within CODESYS. 

1. Right click on ApplicaƟon and then Add Object->VisualizaƟon 
2. It is recommended aŌer the visualizaƟon is created to right click on it and adjust the properƟes such that it has a fixed size compaƟble 

with the display screen size of 800x480 pixels. 

 
3. From here create your HMI as you normally would within CODESYS 
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SWITCHING BETWEEN SCREENS IN YOUR APPLICATION 

If your applicaƟon has more than one screen, you will need a way to change which screen is being shown on the display. There are many 
methods to do this, and most can be found by doing a quick search on the internet or using one of the many CODESYS examples, but here 
is one of those methods. 

1. Open the VisualizaƟon Manager to find the “Use CurrentVisu variable” and ensure that is checked 

 

2. Create your separate visualizaƟons 

  

3. To change what visualizaƟon will be visible you will need to make use of that CurrentVisu variable by seƫng it equal to the visualizaƟon 
you wish to show. 
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This small example is making use of the buƩons to change to a specific screen which sets the CurrentVisu variable equal to the name of 
the visualizaƟon you wish to have shown.  
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CHANGING OF SPLASH SCREEN 

The splash file is a special file that represents the image used for the boot Ɵme splash screen. This file cannot be made within CODESYS, 
but it can be transferred/downloaded from within the CODESYS environment. 

To do this you will need to create an image outside of the CODESYS environment following a few simple rules: 

1. The image type is one of: PNG, BMP, JPG, or GIF 
2. The file name is named splash with no file extension. 
3. The resoluƟon of the file must be exactly 800x480. 

Once the file is made you will be able to add it to your project by right clicking on ApplicaƟon -> Add Object -> External File which will bring 
up a window for you to navigate to the file and select an opƟon: 
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Please ensure to keep the Target Path empty, there are internal scripts within the display that will properly place the file on the target. You 
may select “Embed into project” opƟon if you wish to keep the image saved/contained within the project itself, though it is not required. 

Once added to the project you should be able to see the splash within your ApplicaƟon tree structure: 

  

AŌer the image is added to the applicaƟon you may login to your device and download as you normally would and applicaƟon (following 
secƟon below). That will get the file onto the device, but the splash will not be immediately available. The device will need to run some 
internal scripts on a reboot which will relocate the needed file and force another reboot of the device. Upon that second reboot, your 
splash image should appear as the splash going forward. 

PROGRAMMING DISPLAY THROUGH CODESYS 

By default, your display should come with the CODESYS runƟme installed on it from the factory. To download your CODESYS applicaƟon to 
it you will need the M12 USB cable connected to the USB port on your display, and you will need to have the proper drivers installed in 
order for the device to be found/recognized. To obtain the drivers you will need to download HED’s Linux Device Downloader (LDD). The 
tool, while not directly used with a CODESYS display, will install all the necessary drivers for interfacing with the display. You can contact 
HED’s Technical Support (technicalsupport@hedcontrols.com) to obtain the download if needed. 
 
1. Power the display up and then plug the USB into your PC. From there you can double-click on the top level device in your project. 
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2. Next, under CommunicaƟon Seƫngs click Scan Network. 
 

 
 

3. Once the scanning window comes up you can click the scan network and look for the Linux-Display. 
 

 
 

4. Double-click on the display, you may be asked to create a user management profile for that display if you have not done so already, if 
you have then proceed logging into the user account. AŌer logging in your target should show as the Linux Device. 
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5. Once the target is set you can then load your applicaƟon by selecƟng the Online->Login, Alt+F8, or clicking the log in icon at the top. 
This will prompt the download of your applicaƟon. 
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PRE-PROGRAMMING OPTION 

We offer a pre-programming opƟon where you provide HED the necessary files and we place your applicaƟon on the display(s) in 
producƟon so they ship ready to go from the factory. To take advantage of this, please work with your HED Sales RepresentaƟve. 
 
The file(s) we would need would be the .projecarchive file. To create a project archive: in your project, select File -> Project Archive -> Save 
Archive. Once the file is created send that to us along with any permissions informaƟon we may need, pending your permissions and user 
management within the project, to open the project to download to a display. 
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